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Chapter 1
About WordSpring

WordSpring is for teachers who want a simple to learn, easy to use,

methodology-free, comprehensive resource to support the inclusion of phonics

into their literacy programs. WordSpring has extensive library of words and lists

organized in 24 categories that illustrate all the important phonics concepts

needed for decoding, spelling, and vocabulary development. The categories

begin with one-syllable words containing one short vowel and expand in

complexity to include words that require the application of specific

syllabification rules and accenting hints. The lists, because they include words

from beginning to advanced levels, are suitable for students of all ages and

skills. WordSpring is adaptable to most teaching methods.

Teaching language arts, especially to dyslexic students, is challenging. Lessons

must be structured to address the specific strengths and weaknesses of the

students as well as their ages and skills. WordSpring assumes that the teacher

knows how to do this, that she has in mind the structure of the lesson that she

proposes to give, and that she needs word lists to illustrate the concepts to be

taught. WordSpring makes assembling these lists easy and quick. It provides

printouts of the word lists for incorporation into lesson plans, for giving to

students, and for other purposes and allows the word lists to saved in files for

later use.

LessonPlanner and Scope & Sequence

WordSpring is a companion to Lexia’s other lesson planning tools:

LessonPlanner, and Scope & Sequence for Literacy Instruction by Carol Murray.
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LessonPlanner, and Scope & Sequence for Literacy Instruction by Carol Murray.

LessonPlanner helps teachers structure complete lesson plans in the format used

in Orton-Gillingham approaches, and in particular the Slingerland approach.

Whereas WordSpring provides word lists that illustrate the concepts important

for students to master, LessonPlanner integrates these lists into complete sets of

plans, keeps track of what has been taught, and incorporates lesson components

on learning to write, reading for comprehension, and writing from dictation and

independently.

Comprehensive scope and sequence guidance is available in Carol Murray’s text

Scope & Sequence for Literacy Instruction (published by York Press). It

provides direction for what concepts to introduce, when to introduce them and

how much students can be expected to learn within particular time frames.

Scope & Sequence provides guidance on what words the lists used in a plan

should contain at different stages of instruction.

You can obtain more information about LessonPlanner and order the program

by going to our web site: www.LexiaNet.org. Scope & Sequence can also be

obtained from Lexia through its web site.

WordSpring 2.5 Features

WordSpring 2.5 provides the following features:

 
• 16,000 dictionary (real) words that can easily and quickly be

arranged from 1000s of word lists. This is 1000 more words than
in the previous version of WordSpring.

 

• 6000 one-syllable short and long vowel nonsense words
illustrating the consonant-vowel-consonant (cvc), vowel-
consonant-e (v-e) structure and many of the di/trigraph,
phonogram, r-controlled phonogram concepts that students should
learn to decode. This is 3500 more words than in the previous
version.

 

• Lists organized in 24 categories that illustrate all the important
phonics concepts needed for decoding, spelling, and vocabulary
development. Word lists have been made more complete and
carefully checked for accuracy..
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• The ability to select di/trigraphs (e.g., ph and dge, respectively),
phonograms (e.g., ai and eigh), affixes (e.g., -able and - cial),
Latin and Greek roots (e.g., ject and flex), and homonyms (e.g.,
altar/alter), to mention but a few, that you want in your lesson.

 
• The ability to select words of 1, 2, 3 or more syllables or words

that have consonant-vowel-consonant (cvc) structure and to add
nonsense words to your word lists.

 • The ability to select either dictionary words or nonsense words.

 
• The capability to select words illustrating over a dozen specific

spelling generalizations and rules from the double f, 1, s, z
generalization to the extended 1-1-1 rule.

 • The capability to select words that apply the four syllabification
rules with the corresponding syllable patterns.

 • The freedom to choose lists arranged in random, consonant-
vowel-consonant, or alphabetic order, as you prefer.

 
• Teaching tips and guidance for language concepts (lists),

descriptions of spelling and syllabification rules, and definitions of
endings, suffixes, Greek forms, and Latin roots.

 
• The power to customize lists to meet students' specific needs, to

build on previous lists, and to share lists with other teachers by e-
mail, network, or disk.

 
• The power to customize lists to meet students' specific needs, to

build on previous lists, and to share lists with other teachers by e-
mail, network, or disk.

 

• The flexibility to print lists in many formats including large
print decoding and spelling work sheets and student stick-on
labels with pronunciations, if desired. In version 2.5 words can be
sequence vertically or horizontally and print formats can be
customized to meet special requirements.

 • Dictionary pronunciations compatible with Orton-Gillingham-
based approaches for all 22,000 dictionary and nonsense words.
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Chapter 2
Getting Started

 

Computer requirements

To use WordSpring on a Windows computer we recommend the following

equipment:

 

• a Pentium II or later computer with at least 256 megabytes (MB)
of random access memory, a hard disk with at least 50MB of
space available for the WordSpring program, a color monitor with
at least 1024 x 768 pixels (it will work on a monitor with 800 x
600 pixels), and a CD drive

 • Windows 2000 or Windows 2000XP or later operating system (it
will work on many but not all Windows 98 operating systems)

 • An Internet connection is required for software registration

To use WordSpring on a Macintosh, we recommend:

 

• a Macintosh with a G3 or later processor, with at least 256
megabytes (MB) of random access memory, a hard disk with at
least 50MB of space available for the WordSpring program, a
color monitor with at least 1024 x 768 pixels (it will work on a
monitor with 800 x 600 pixels), and a CD drive

 • Mac OS X version 10.3 or later operating system

 • An Internet connection is required for software registration

What You Should Know

You should know how to structure your language arts lesson, that is, know what

phonics concepts you want to teach. WordSpring will help you construct the

word list to use in teaching these concepts, but provides only limited guidance

about scope and sequence. For help in this area, users will find Scope and

Sequence for Literacy Instruction by Carol Murray (York Press, now available

from Pro-Ed, Inc.) of value.
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from Pro-Ed, Inc.) of value.

Installing WordSpring

On both Macintosh and Windows the first few installation steps are the same.

Detailed instructions for installing WordSpring on Macintosh and Windows

operating systems are in the Appendix. However, the following instructions

should be sufficient for most installations:

 

- Make sure you do not have a folder on your hard drive named
"Lexia WordSpring 1.1.1" or" Lexia WordSpring 2.0". If you do,
save any word lists you want to preserve in a new folder named
something like "Old Lexia WordSpring Data" and then "Remove"
the Lexia WordSpring folder (Windows) or move the folder to
Trash (Macintosh). To "Remove" a program in Windows, open
Control Panels (which is accessed by clicking on the Start button
at the bottom and on some versions of Windows by clicking on
Settings) and then double click on the Add/Remove Programs
icon. Select Lexia WordSpring and click the Add/Remove button.

 - Exit all other applications that are running on your computer by
clicking File > Exit (Windows) or File > Quit (Macintosh).

 

- Insert the Lexia WordSpring CD in the drive. The installation
should start automatically. If it does not: on Windows open (by
double clicking) the My Computer icon on the Desktop, and then
double click on the CD drive icon named WordSpring. On
Macintosh, to start installation open (double click) the CD drive
icon named WordSpring on the Desktop.

 

- In one of the installation steps, the Readme file should be
displayed. We suggest that you read this file for information
about installation and about the software. If the Readme file does
not appear during the installation process, it can be found on the
WordSpring CD and in the Lexia WordSpring 2.5 folder that is
installed on your hard drive. The User Manual is also on the CD
and in the Lexia WordSpring 2.5 folder.

Completing Installation on Macintosh

On Macintosh, complete the installation by doing the following:

- Note that the CD contains installation folders for two Mac
operating systems. The Macintosh OS X operating system
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operating systems. The Macintosh OS X operating system
requires an administrative password for the Installer to place a
special font used by WordSpring in the System fonts folder. If
you know this password, select and open the "OS X with
password" folder. Otherwise open the "OS X without password"
folder. Without the password you may have to install the special
font, LPCourier, manually in your own user Fonts folder
(Macintosh HD > Users > Your UserName > Library > Fonts). In
some sites this special font is already part of the standard system
Fonts folder configuration, and you do not have to worry about
installing it. To determine if it is already installed, open:
Macintosh HD > Library > Fonts, and see if LPCourier is there.

 
- Double click on the WordSpring 2.5 Installer icon to start the

installation. The software will be installed in your Applications
folder unless you choose to install it somewhere else

 - Follow the instructions that appear on your screen.

 

- If you are installing without having an administrative password
and if the LPCourier font is not in the system font folder
(Macintosh HD > Library > Fonts), you will have to install it
manually from the WordSpring CD or from the Lexia
WordSpring 2.5 folder. Without this font, WordSpring will not
function correctly. There are several ways of doing this. One
way, is to go to Finder, locate your user font folder (Macintosh
HD > Users > Your UserName > Library > Fonts), make an alias
for this folder by clicking on File > Make Alias, and drag this
alias onto the desktop. Next, in Finder locate the LPCourier font
in either the WordSpring CD or in the Lexia WordSpring 2.5
folder on your hard drive (Macintosh HD > Applications > Lexia
WordSpring 2.5). Drag the LPCourier font to the Fonts alias you
put on your desktop.

 
- When the installation is completed, you should restart your

computer. An icon for starting WordSpring will be placed on your
desktop.

 

- We suggest that you read the Readme file for information about
installation and about the software. If the Readme file does not
appear during the installation process, it can be found on the
WordSpring CD and in the Lexia WordSpring 2.5 folder that is
installed on your hard drive.

Completing Installation on Windows

On Windows complete the installation process by doing the following:

- Double click on the Setup icon in the CD to start the installation.
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- Double click on the Setup icon in the CD to start the installation.

The software will be installed in your Programs folder unless you
choose to install it somewhere else.

 

- When the installation is completed, you should restart your
computer. An icon for starting WordSpring will be placed in the
Programs list that can be opened from the Start menu. You may
also want to move a shortcut to WordSpring to your desktop.

The installation process creates the Lexia WordSpring 2.5 folder in your

Programs Directory (Windows) or Applications Folder (Macintosh) unless you

specified a different location, adds Lexia WordSpring to the Programs list in the

Start menu (Windows), and places a Lexia WordSpring icon on your desktop

(Macintosh). Before starting WordSpring we suggest that you print out or read

the Readme file and the WordSpring User Manual. They are both on the

WordSpring CD and also in the Lexia WordSpring folder that was installed on

your hard drive. The User Manual and the Readme files are in both Adobe

Acrobat (pdf) format. If you do not have Adobe Acrobat Reader or an equivalent

program already installed on your computer, you can obtain it from the Adobe

website. Go to www.adobe.com and click on the "Get Adobe Reader" icon on

the left side of the page. Then follow instructions to download the software.

Starting WordSpring

To start WordSpring:

 - Click the Lexia WordSpring icon on the Desktop.

 

- If a WordSpring icon is not on the Desktop, you can start the
program in Windows by clicking Start > Programs and then Lexia
WordSpring 2.5 in the list of programs or by clicking on the
WordSpring.exe file in the Lexia WordSpring 2.5 folder. On the
Macintosh you should click on the icon labeled “WordSpring 2.5
Program” within the Lexia WordSpring 2.5 folder, which is
usually in the Applications folder. The WordSpring screen should
now appear on your monitor unless this is the first time you are
using WordSpring. If it is the first time, you will instead see a
registration screen. The registration process is described below.
Registration

Registration

The first time you use WordSpring you will be asked to register your software
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The first time you use WordSpring you will be asked to register your software

on our server. This requires an Internet connection. You will be asked to enter a

Registration Number or Key. It is either on your WordSpring CD or on its case.

You will also be asked for information about how we can contact you to provide

information about new releases of WordSpring. The Registration process allows

you to install, and reinstall if necessary, your copy of WordSpring on a single

computer . If you acquire a new computer, you will need to call or e-mail us to

reset your Registration Key so you can install on a different computer. If you

need to install WordSpring on your home and school computers, call us about

purchasing an extension to your license that will enable this. The additional cost

is modest.

Adjusting the Display

There are two adjustments you should make to the way in which WordSpring is

displayed. The first is to adjust the size of the WordSpring panel and to align the

panel with the menu bar at the top of the screen. The second is to adjust the

number of pixels used by the display monitor so that the font used by

WordSpring is readable.

Adjust the size of the WordSpring screen on the display so that it is wide enough

to make all the windows visible and high enough to show all the entries in the

[Categories] window. On Macintosh:

 

- Click the green Maximize button (the button containing a + sign)
at the top left of the screen. That will make the screen as large as
possible. To adjust it further, grab the lower right corner or the
right edge of the screen with the mouse cursor and drag it so that
the screen has the desired size. You can also just click on the
Maximize button at the top of the screen.

On Windows:

 

- Maximize both panels on the display. If either of the two
Maximize/ Restore buttons at the upper right of the screen

contains an , click on the button so that the screen is
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contains an , click on the button so that the screen is
maximized and the panels are aligned. When you do this, the
display adjustment buttons at the upper right should look like:

 

 

- To change the size of the Windows display when the
Maximize/Restore buttons are as shown above, click on the upper
Maximize/Restore button and then grab the lower right corner or
the right edge of the screen with the mouse cursor and drag it so
that the screen has the desired size. The buttons will have the
following appearance:

 

The most desirable display resolution for operating WordSpring is 1024 by 768

pixels. If there are more pixels than this, the text on the display will be small

and hard to read. If there are fewer pixels, you will have to scroll the windows

of the WordSpring panel to see all the information. To set the display resolution

on Macintosh:

 - Click on the System Preferences under the Apple menu at the top
left of the screen.

 - Click on Displays located in the Hardware row.

 

- Click on 1024 X 768 in the resolutions window. If you have a
choice of refresh rate (60 Hz, 70 Hz, etc.), choose the same
refresh rate as in your original the resolution setting. 60 Hz
should work fine in most situations.

 - Close the Display panel.

To set the display resolution on Windows:

-
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 - Click on the Start button on the lower left of the display.

 - Click on Settings and then Control Panel.

 - Click on Display.

 - Click on the settings tab near the top of the display.

 - Slide the screen area pointer left or right so that it shows 1024 by
768.

 - Close the Display Properties Panel and the Settings Panel.

Documentation

Several documents are provided with WordSpring to help you use the software:

the Readme file that has the latest information about installation and operation;

the User Manual: and the Guided Tour to WordSpring that provides an overview

and demonstration of what WordSpring provides and how to use it. This

documentation is in several places: on the installation CD, and in the

documentation folder that is within the Lexia WordSpring 2.5 folder. If your

installation CD automatically starts to install the WordSpring software when it is

loaded into the CD drive, you can access to the documentation files on the CD

by interrupting the installation process. When you do this, the files can be

accessed in the normal way by using: Windows Explorer or Macintosh Finder or

an application like Adobe Acrobat.

The user manual can also be accessed when running WordSpring by clicking on

Help in the menu bar and selecting User Manual.
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Chapter 3
Using WordSpring

 

WordSpring is simple to use, and this part of the manual is short. We will show

you, through examples, how to do the following:

• create word lists

• print lists for use in class

• save lists on your hard drive for use at a later time or to incorporate
in your lesson plan document

• modify lists you have saved

It is helpful to know that WordSpring has been built using another software

system called a database management system. It provides facilities for

organizing the data that lie at the core of WordSpring.

Contextual Help Command

Before beginning to use WordSpring note you can obtain Contextual small pop-

up messages, called Contextual Help, that explain the functions of windows,

buttons, and other information on the WordSpring screen. You can make these

messages appear or disappear by clicking Utility in the menu bar and then on

Contextual Help. If a check mark is next to Contextual Help, the messages will

appear. Otherwise they will not.

An overview of WordSpring

Word lists are created using the WordSpring main panel, which has three main

windows as shown in Figure 1:

• the [Categories] window that is used for accessing the word lists
available in WordSpring;

• the [Examples] window that is used for displaying example words
from these word lists;
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• the [User Selections] window that is used for assembling words
into lists that will be used in a lesson.

Figure 1. WordSpring screen showing the three primary windows and all 24
categories in the [Categories] window.[Note: WordSpring screens are shown as
they appear on Macintosh. Windows screens differ slightly, but the functionality
and operation is the same.]

WordSpring divides word lists into a set of 24 categories, each of which

illustrate a key decoding, spelling, or vocabulary building concept. Each

category is in turn divided into subcategories that provide specific examples of

the concept illustrated by its parent category. In this structure, for example,

closed syllables (also referred to as short vowels) is a category and the six

vowels (a, e, i, o, u, and y) are the subcategories.
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vowels (a, e, i, o, u, and y) are the subcategories.

To create a word list of short vowels:

- Select the category by double clicking with the mouse on the
closed syllable (short vowel) category name in the [Categories]
window or by clicking on the [+] sign (Windows) or the [arrow]
symbol (Macintosh) to the left of the category name. The
subcategories will then show.

- Click on the subcategory “i”, and a list of words illustrating this
vowel with its short vowel sound will appear in the [Examples]
window in the middle of the panel. There are a number of ways in
which you can filter and order this list to obtain words of desired
difficulty. These are discussed later

- Double click a word in the [Examples] window that you want to
use in the lesson. It will move to the [User Selections] window on
the right of the screen. There are a number of ways that you can
move words to the [User Selections] window. These also are
discussed later. Double click on other words in the [Examples]
window to add them to the list in the [User Selections] window.

 

- Print the word list in the [User Selections] window by clicking
Print in the menu bar at the top of the screen, then clicking Lists,
and then choosing one of the printing formats provided in the
dialog box that appears.

 

- Save the word list so that the list is available for use later or for
reformatting with your word processor by clicking File > Save in
the Menu Bar at the top of the screen, selecting a folder in which
to save the list, and assigning a name to the list.

That’s basically all there is to it. WordSpring, however, provides many other

facilities to make the process of creating appropriate word lists more flexible,

easier, and faster. These are discussed in the next few sections.

Categories & Subcategories

The [Categories] window is on the left side of the main WordSpring screen. All

the lists in the WordSpring database are grouped into 24 categories, visible in

the [Categories] window in Figure 1. Each category focuses on an important

decoding, spelling, or vocabulary concept that students should master, for

example: closed syllables, spelling generalizations, and Latin and Greek roots.
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example: closed syllables, spelling generalizations, and Latin and Greek roots.

The 24 categories encompass all the principal concepts that should be taught in a

literacy program for decoding, spelling, and vocabulary development. Related

categories are grouped together in the [Categories] window and separated from

other groups by dashed lines.

When a category is selected by clicking on it, a brief description of that category

appears below the [Categories] window. The categories are divided into

subcategories, each illustrating a different application of the concept represented

by its parent category. For example, the closed syllable (closed vowel) category

is divided into six subcategories, one for each vowel (a, e, i, o, u, and y). To

expand a category to see its subcategories, click on the plus sign [+] (Windows)

or the [arrow] symbol (Macintosh) to the left of the category name or simply

double click on the category name.

In Figure 2 we have expanded the closed syllable (short vowel) category so that

the six subcategories are revealed. When the category is expanded, the symbol

to the left of the category name changes from a [+] to a [-] (Windows) or from a

[horizontal arrow] to a [down arrow] (Macintosh). If you want to hide the

subcategories to make the category list shorter, just click on the [-] sign or

[down arrow] symbol, double click on the category name, or click on the label 

“Categories” just above the [Categories] window.
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Figure 2. Closed syllable category expanded to show subcategories. Note the
explanation of the closed syllable category below the [Categories] window.

When a subcategory is selected and a keyword is available to illustrate it, the

keyword and (if appropriate) its pronunciation are presented below the

[Categories] window. In addition, descriptions or definition of the subcategory,

tips for how to teach the concept represented by the subcategory and other

useful information are provided in this window.

Occasionally, you will find that you have opened several categories and that the

number of items in the [Categories] window is too large and scrolling through

the long lists is tedious. To collapse all the lists of subcategories and restore the

[Categories] window to its original appearance, click on the label “Categories”
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[Categories] window to its original appearance, click on the label “Categories”

above the [Categories] window, or click on the Collapse All Lists command in

the Utility menu in the menu bar. This command can also be initiated by typing

ctrl+F (Windows) or command+F (Macintosh)

Creating a Word List

We will now work through a particular example in which we create a word list

for a beginning decoding lesson introducing the closed syllable (short vowel) “i”

and reviewing the closed syllable “a”.

 

Getting Word Examples

The first step is to get a set of words illustrating the closed syllable 

“i” that are candidates for use in the lesson. To get these examples,

select the closed syllable (short vowel) category in the [Categories]

window:

- Click once on the closed syllable (short vowel) category
to select it. It is the second entry in the list of categories.
Note that a description of this category appears just below
the [Categories] window.

To see the subcategories:

- Click on the [+] symbol (Windows) or the [arrow] symbol
(Macintosh) to the left of the category name, or

 - Double click on the category name.

The list of six Subcategories, a, e, i, o, u, and y, appears. To obtain a

set of words containing the closed syllable “i:

- Click on “i” in the [Categories] window and note that the
key word [i]nch and its pronunciation appear below the
[Categories] window. Note the keyword, its pronunciation,
and the teaching tip in the text window below the
[Categories] window.
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A list of words containing the closed syllable “i” words appears in the

[Examples] window in the middle of the screen as shown in Figure 3.

Figure 3. Examples of closed syllable “i” words shown in the [Examples]
window.

 

Working with the Examples Window

Words in the [Examples] window can be arranged in several ways and

can be restricted to words composed of a specific number of syllables

or to words that have a consonant-vowel-consonant (c-v-c) structure.

This process of restricting the words in a subcategory that appear in

the [Examples] window is called “filtering”.

You also have the option of displaying nonsense words rather than

dictionary (real) words. In this version of WordSpring nonsense words

are limited to one-syllable, short and long vowel words of consonant-

vowel-consonant (c-v-c) or vowel-consonant-e (v-e) structure.
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vowel-consonant (c-v-c) or vowel-consonant-e (v-e) structure.

The small [Display] window just below the [Examples] window is

used to select the filter that will be applied to the words in the

subcategory. Only words satisfying the filter will appear in the

[Examples] window. The [Display] Window allows you to restrict the

words in the [Examples] window to 1-syllable words, 2-syllable

words, 1- or 2- syllable words, 3- or more syllable words, all words

without regard to number of syllables, or to words that have a c-v-c

structure. WordSpring filters out the words that are not of the type

selected. Initially, the 1 or 2 syllable filter is selected when you start

WordSpring.

Just below the [Display] Window are two choice buttons that allow

you to select either dictionary or nonsense words. Nonsense words are

useful for building decoding and spelling skills because the student

cannot use word recognition to by-pass explicit decoding and spelling

processes. However, it should be noted that pronunciation of many

nonsense words is not unique. A single construct, such as the

phonogram ea, may have several pronunciations (as in eat, steak, and

head). It may not be possible to determine which one to use in a

particular nonsense word. This ambiguity provides a valuable teaching

opportunity for discussing the several ways a phonogram,

digraph/trigraph, or other construct of our language can be

pronounced for both decoding and spelling.

The small [Sort] window below the [Display] window is used to

arrange the words in the [Examples] window different ways. This

operation is called Sorting. When WordSpring is started, the Unsorted

option is selected, which means that words appear in random order in

the [Examples] window. The other sort options allow you to arrange

the words in alphabetic order, by number of syllables, or in
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the words in alphabetic order, by number of syllables, or in

consonant-vowel-consonant (c-v-c) order. The c-v-c option displays

simple c-v-c (one consonant, one vowel, one consonant) words appear

first, followed by c-v-cc words, followed by cc-v-c words, followed

by cc-v-cc words, and followed by cc-v-ccc and ccc-v-ccc words.

Consonant-vowel-consonant ordering is available only for 1-syllable

words.

It may seem strange to have the c-v-c option available in both

windows, but the c-v-c option as implemented in WordSpring filters

out words that are not c-v-c words and also arranges the c-v-c words

by the complexity of their c-v-c structure. Because c-v-c is both a

filtering and a sorting operation, c-v-c appears both in the [Display]

and in the [Sort] windows. When it is selected in one window, the

other window is automatically set to c-v-c. To unselect c-v-c words,

you must choose another option in the [Display] window, for example

2-syllable words. You cannot return to multi-syllable words by

choosing another option in the [Sort] window, for example

alphabetical.

The [Maximum words] window below the [Sort] window determines

the number of words that will appear at any one time in the

[Examples] window. This is initially set to 100 words, all of which

can be seen if you use the scroll bar at the right of the [Examples]

Window. You can change the Maximum words setting by typing a

different number into the [Maximum words] Window.

Note the red numbers at the upper right corner of the [Examples]

window, 100/1329 (or numbers close to these). The first of these

numbers indicates that there are 100 words actually in the word list

currently shown in the [Examples] window. The second number

indicates the total number of words in the subcategory you have
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indicates the total number of words in the subcategory you have

chosen that have the number of syllables set in the [Display] window.

The [Display] window is set to 1 or 2 syllables. The red number 1329

at the upper right corner of the [Examples] window is the number of

1- or 2- syllable words in the closed syllable “i” subcategory. If there

are no words in the list for the Display settings you have chosen, the

message “No words found” will appear instead of the numbers.

When WordSpring encounters lists longer than the number set for

[Maximum words], it displays a randomly chosen sample of about ten

per cent of all the words in the list. In Figure 3, the numbers at the top

right of the [Examples] window indicate that there are 100 words in

the first sample of the full list of 1329 words. A second sample of

words from the full list can be obtained by clicking again on the

subcategory name in the [Categories] window.

Now select a 2-syllable word in the [Examples] window by clicking

on it once. Note that the pronunciation, syllabification, and accenting

of the selected word appears below the [Examples] window. The

pronunciation uses standard dictionary pronunciation symbols

compatible with Orton-Gillingham instruction. Pronunciations are

available for all the words in the database.

We have described all the facilities associated with the [Examples]

window. Let us now illustrate how to use these facilities to obtain a

word list for our lesson in which we introduce the closed syllable “i”

and review the closed syllable “a”.

To obtain words containing only one syllable, we must change the

[Display] setting. To do this:

- Click on the small arrow at the right of the [Display]
window and the filter options will appear in a pop-up list.
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- Click on 1 syllable and note that the words in the
[Examples] window have changed. Only 1- syllable
words appear. Also, the word count at the top right of the
screen has changed.

If you were interested in working with longer words, you could have

selected 2 syllable or 3 or more syllables in the [Display] window.

For each of these you will get different lists of words corresponding

to the filter selections.

Check to make sure that Dictionary Words is selected just below the

[Display] window. If you want to work with nonsense words, click in

the circle just to the left of “Nonsense Words”. Remember only one

syllable nonsense words are in the database so if you select 2 syllable

in the [Display] window, no words will appear in [Examples] and the

message “No words found” will appear above the [Examples]

window.

If you wanted the lists in the [Examples] window to be shorter than

100 words to simplify word selection, you should type some other

number in the [Maximum words] window. To see what happens:

- Type 15 into the [Maximum words] window.

 - Press the Enter (Windows) or the Return (Macintosh)
key.

Note that the list is shortened and the word count numbers change.

Since we are making a list for a beginning class, we might want to

work first with simple consonant-vowel-consonant words and then go

to more complex words. It would be useful, therefore, to have the

words in [Examples] in c–v–c order. To do this:
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words in [Examples] in c–v–c order. To do this:

- Click on the small arrow at the right of the [Sort] window
and the sort order options will appear in a pop-down (or
pop-up) list.

 - Click on c–v–c.

Note that the words in the [Examples] window are now ordered by

their consonant-vowel-consonant composition. Simple c-v-c words

appear first, followed by c-v-cc words, followed by cc-v-c words,

followed by cc-v-cc, and followed by cc-v-ccc words. When c-v-c

order is selected in the [Sort] window, the [Display] window is

automatically set to c-v-c to reflect the fact that only 1-syllable, c-v-c

words are shown in the [Examples] window.

You could also have selected c-v-c in the Display window, and you

would have obtained the same list of words in [Examples].

Selecting Words for Your Lesson

Words that you will actually use in your lesson are assembled in the

[User Selections] window at the right of the screen. WordSpring

provides a number of ways for moving words into this window. The

[User Selections] list can be printed for use in class or saved to a file.

You can move individual words from the [Examples] window to the

[User Selections] window by:

• Double clicking on the word;

• Clicking once on the word (selecting the word)and
dragging it to the [User Selections] window;

• Clicking on the word and then clicking the blue single
arrow button between the two windows. It is the
uppermost of the set of five buttons located there.
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When you drag the word, it can be placed anywhere in the [User

Selections] word list. When you double click or use the [arrow]

button, the word is appended to the end of the list.

• Experiment with these commands by using them to move
some closed syllable “a” words from [Examples] to [User
Selections]

There are two ways of moving groups of words to [User Selections]:

• Click the [10%] button, which is the second of the buttons
located between the [Examples] and the [User Selections]
windows. Approximately 10% of the words in the
[Examples] list, selected at random, will be moved to
[User Selections].

• Click the blue double arrow button and all the words in
the [Examples] list will be moved.

There are also three ways to remove words from the [User Selections]

Window:

• Click on the word and drag it out of the [User Selections]
window and into the [Examples] window.

• Click on the word in [User Selections] and then click on
the red single arrow button.

• To remove all words from [User Selections], simply click
on the red double arrow button. You will be asked to
confirm this action, and when you do the user [Selections]
Window will be cleared.

To enter any word you want in the [User Selections] list:

- Type the word into the [Add Word] window located just
below the [User Selections] window.

- Click at the point in the [User Selections] list at which
you want the word to be inserted
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- Press Enter (Windows) or Return (Macintosh), or click on
the blue single arrow button, and the word will be
inserted in the [user Selections] list below the point
highlighted.

Pronunciations are available for words in [User Selections] that came

from the [Examples] window. Pronunciations are not available for

words typed in, unless they happen to be in the WordSpring database.

To obtain the dictionary pronunciation:

- Click on the word, and the pronunciation will appear
below the [User Selections] window.

Reordering Your Word List

You can change the order in which words appear in the [User

Selections] window simply by selecting the word and dragging it to

the desired position in the list. You can also arrange the words in

alphabetic order by clicking in the box to the left of “Sort List

Alphabetically” just below the [User Selections] window.

 

Note: Once the list has been sorted alphabetically, it cannot

be returned to its original ordering.

Adding Words from Other Subcategories

Words can be added to the [User Selections] window from other

subcategories. We will illustrate this by adding closed syllable “a”

words for review to the [User Selections] list:

- First, make sure the words in the [Selections] window are
not being alphabetized. If there is a check in the Sort List
Alphabetize check box, cancel it by clicking in the box.

- Click on the closed syllable “a” subcategory. Closed
syllable “a” words will appear in the [Examples] window
in c-v-c order if this option is still selected in the [Sort]
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in c-v-c order if this option is still selected in the [Sort]
window.

 

- Move the words you want to the [User Selections]
window using one of more of the methods described
above. You should now have a list containing both closed
syllable “i” and closed syllable “a” words.

- Put the words in the [User Selections] window in the
order you want by clicking and dragging on the words
you want to move.

You can build lists containing selections from as many categories and

subcategories as you like by continuing in this manner.

Adding Titles and Labels to Lists

A simple way of adding a title to a list is to type the title into the Add Word box

below the User Selections window and then move that title to the appropriate

position in the list. It is a good idea to type the title all in capital letters to

distinguish it from the words in the list. You can use the same method to put a

label in the middle of a list, for example, to identify the types of words that

follow.

You can also add a blank space after or before the title by typing a space in the

Add Word box and then dragging that word into the list. This is useful for

setting off a Title or for separating different parts of a list.

Printing Your Word List

You can print the word list in the [User Selections] window in several different

formats. There are two groups of formats:

• Word lists can be printed on standard paper in one or more
columns in any of several different font sizes.

• Words can also be printed on labels that students can paste in their
notebooks.

You also have the choice of printing just the words or printing the words

together with their pronunciations. Lists without pronunciations can be printed

sequenced vertically in one-column, two-column, three-column formats with the
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sequenced vertically in one-column, two-column, three-column formats with the

paper in the usual portrait orientation. The more compact three-column format is

provided for teachers to use in class. Lists can also be printed with words

sequenced horizontally and the paper in the landscape orientation. Three font

sizes are provided: standard (Std), which is 14 point, large (Lrg), which is 18

point, and extra large (XL), which is 24 point. Words are spaced vertically by

1.5 lines to make them easier to read. When you print the words together with

their pronunciations, only a two-column vertically-sequenced format is provided

because the words and pronunciations are printed side-by-side.

Label formats are similar, but only the Standard and Large font sizes are

available.

To print the word list that is in the [User Selections] window:

- Select the Printing menu from the menu bar at the top of the screen
by clicking on it.

- Select Lists or Labels depending on your preference. For this
exercise, we suggest you select Lists. Several print formats will be
displayed.

 - Select the print format you want from the list presented in the
dialog box by clicking on it.

 - Click on the Print button at the bottom right corner of the dialog
box.

- Click on the desired choices on the standard Print Setup and Print
dialog screens that then appear.

Saving and Retrieving Saved Lists

You can also save your list to a file. You can do this by using the standard Save

command in the File menu. When you choose Save, a standard file dialog screen

appears and you can select a folder in which to save the list. After you make

this selection, you must assign a name to the list. Word lists are stored in “.txt

format”, which simply means that they are simple text documents with very

simple formatting. These documents can be opened by your word processor and

reformatted in the usual way.



12/05/2006 09:33 PMWordSpring User Manual

Page 31 of 42file:///Users/jerome/Desktop/WordSpring2.5UserManual/WS2.5UserManual/Body/FullText.html

reformatted in the usual way.

To save a list:

- Select File > Save from the menu bar at the top of the screen. A
dialog screen will appear. In Windows the dialog screen will be set
initially to save your list in the Default directory, initially the WS
Word List directory within the Lexia WordSpring 2.5 directory.
You can use a different directory, by navigating to it in the
standard way using the dialog screen. On the Macintosh, you must
select a folder in which to save lists every time you save. We
suggest that you save your lists in the WS Lists folder that is within
the Lexia WordSpring 2.5 folder. If you did the usual install, this
folder will be in your Applications directory

- Type the file name that you want to associate with this list. You
might want to use a file name that includes the date or the class
name. If you include the date, some people suggest you use the
format: YYMMDD, such as 021018 WS List, which will result in
file lists that are in chronological order.

 - Click the Save button to save the file.

To retrieve a word list that you saved:

- Select the File menu from the menu bar at the top of the screen by
clicking on it.

- Select Open. The standard Open file dialog screen will appear.

 - Select the file you want to open.

 

- Click the Open button and the word list you selected will be placed
into the [Examples] window, replacing any list that is already there.
You can then filter or rearrange the words in the combined list as
described above and move selected words to the [User Selections]
window for use in your lesson.
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Chapter 4 
Creating Custom Printing Formats

It is quite simple to create custom printing formats (also known as printing

templates) that present printed word lists in a specific font, number of columns,

or number of words per page. This is done with the Label Editor that is accessed

by a command in the Printing menu of the Menu Bar.

A word list is simply a set of labels printed on plain paper. Printing formats are

designed by specifying the layout of a set of labels arranged in the number of

columns and the number of rows that match your needs. Each word or each

word-pronunciation pair is printed on a single label. So a word list of 20 words

or 20 word-pronunciation pairs will require 20 labels. Because word lists are

treated as an arrangement of labels, they were created and are edited with a

software tool call the Label Editor.

To create a custom printing format:

- Make sure there are 20 –30 words in the User Selections window.
These will be required to test the format that you create.

 - Select Print Format Editor in the Printing menu of the Menu Bar

 - Click the Label Editor button in the Edit Templates panel that
appears. The Label Editor panel will appear.

Editing a Print Format

It is easier to create a new printing format by editing an existing one, rather than

starting from scratch. The printing formats provided with WordSpring can be

used as the starting point for creating a new format or adjusted if they are not

exactly what you want. WordSpring is delivered with a number of standard print
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exactly what you want. WordSpring is delivered with a number of standard print

formats. These are the ones that appear the first time you ask WordSpring to

print the [User Selections] list. These formats are stored in the WS Print Format

folder that is within the Lexia WordSpring 2.5 folder.

To load an existing printing format for use with the Label Editor:

- Open the Label Editor as described above.

 - Click the Load button at the bottom of the Editor panel, and a
standard file dialog box will appear.

 

- Locate the printing format that you want to edit in the WS Printing
Formats folder within the Lexia WordSpring 2.5 folder located in
Applications (Macintosh) or Programs Folder (Windows) (or some
other folder you have used for storing printing formats).

 - Click Open. The label design and layout from the selected format
will be loaded into the Label Editor and be ready for editing.

Layout Design

It is usually best to start the print format design by specifying how the labels

containing the words or words and pronunciations will be laid out on the printed

page. To do this first:

 - Click on the Layout tab at the top of the Label Editor panel. The
Layout Editor will appear (shown in Figure 4)
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Figure 4. Layout Design panel of the Label Editor

Then:

- Specify whether you want the page to be printed in portrait
(vertically) or landscape (horizontally) by clicking the appropriate
Orientation icon at the top left of the dialog box.

 

- Specify whether you want the words in the list to flow down one
column and then down the next or across a row and then across the
next by clicking the appropriate Label Or… icon(Label Order icon)
at the top of the dialog box.

 

- Choose the number of columns that you want by entering the
appropriate number in the Labels Across box. Remember that
pronunciations are on the same label as their word. If the word and
pronunciation are arranged side-by-side, one column of labels will
contain both, but they will appear as two columns on the printed
page. As you increase the number of columns, you decrease the
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page. As you increase the number of columns, you decrease the
width of the labels and the number of letters that will fit on a label.
For large font sizes or long words, the maximum number of
columns will be two.

 - Choose the number of words that you want in each column by
entering the appropriate number in the Labels Down box.

Next, adjust the margins and spacing between labels. Since all the labels you

specified above must fit on the page, increasing the margins or spacing will

decrease the size of the labels. This may make it necessary to go back and

change the number of columns and the number of words in each column. To

adjust margins and spacing:

- Set the page margins by clicking the Page Size radio button and
typing into the Top, Left, Right and Bottom Margin boxes. You
may want to change the Unit to Inch or Centimeter (instead of
Point) to make the margin sizes more familiar

 

- Click in the Automatic Sizing check box and the labels will adjust
automatically to fill up the page. 
[Note: Automatic Sizing does not work correctly when the page has
a landscape orientation. You will have to set the label size
manually]

 

- Set the horizontal and vertical spacing between labels by typing
into the Horizontal and Vertical Gap boxes. Since you can also
control (see the Label Design section) how words are laid out in a
label, it is usually not necessary separate the labels.

Label Design

Next specify how the words and pronunciations will appear on each label.

Remember, Each word in the WordSpring [User Selections] list and each word-

pronunciation pair is printed on a single label.
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Figure 5. Label Design panel of Label Editor.

- Select the Label tab at the top of the panel. The Label design panel
will appear (shown in Figure 5).

 - First, make sure that that the Form to Use box near the bottom of
the page contains “No Form”

 

- Drag the fields that you want in the labels (if they are not already
shown on the label)—word, word and pronunciation, or
pronunciation alone—from the List of Fields window on the upper
left into the white label in the Label Preview area to its right.

 

- Select text fields by clicking on them and then choose the desired
Font, Font Size and Alignment from the Text area below the Label
Preview area. Also select the Style options you want: bold, italic,
or underlined by clicking in the boxes to the right.
[Note: For pronunciations to print correctly you must choose the
LPCourier font. Any font can be used for words]
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 - Align the text fields in the label by adjusting location so that you
have sufficient margins around the words.

 
- You may want pronunciations to the right of its corresponding

word or below it. Move the pronunciation field so that it is aligned
properly with its word.

 

- You can use the Object Look area to specify the color of the font
and whether the labels have borders. Usually, the Background will
be white, the Foreground (text) will be black, the Border will be
white, and the Fill will be white.

Saving Print Formats

To save the label you have just designed:

- Click on the Save button at the bottom of the dialog box. A
standard file dialog box will appear.

 

- Select the file folder in which you want to store your label format.
We suggest you put it in the WS Print Formats folder that is within
the Lexia WordSpring 2.5 folder in Applications (Macintosh) or
Programs (Windows).

 
- Give an appropriate file name to the print format. Give each

printing format a distinguishing file name (e.g. Words, 3 columns
XL vertical).

 

- Click Save. Your format will be saved in the selected folder, and it
will also be saved as a template within WordSpring so that the new
printing format file name will be added to the set of lists or labels
that comes up when you click the List or Label commands in the
Printing menu. You will then be returned to the Label Editor.

 
- Click Cancel to exit the Label Editor and you will see a dialog

asking whether your format is a list or a label. Select list unless
you have designed the format to print on label stock.

 
- Click Done on the Edit Templates dialog that appears. You will be

returned to the WordSpring main panel and be ready to use this
new template.

Verifying a Print Format

The best way to determine whether the print format you just designed is

satisfactory is to create a sample word list in User Selections and print it. If

changes are needed, you can edit the format by opening the label editor and

loading the format to be edited as described at the beginning of this Chapter.
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loading the format to be edited as described at the beginning of this Chapter.

You can also print and verify a printing format before saving the format by

clicking the Print button at the bottom of the Label Editor panel. We recommend

that you save your design as soon as it is completed to avoid losing your work if

there should be a computer problem.

Importing List and Label Templates

To facilitate distribution of new printing formats, the Utility menu in the menu

bar has two special commands: Import List Template and Import Label

Template. These commands open a standard open file dialog screen that you can

use to find the folder containing the templates you want and then click Open.

The templates will be imported into your printing format database for future use.

The WordSpring CD Print Format folder contains templates that have already

been imported into WordSpring. If you accidentally deleted one of the formats

from WordSpring, you can recover it by importing from the this folder. We may

distribute additional printing templates by e-mail or have them available on our

web site for downloading.
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Support

If you have a problem using WordSpring that you can’t resolve, we are ready to

help. You can reach us in the following ways:

Electronic Mail

info@LEXIAnet.org

Electronic mail is the best way to reach us. Write down your problem as

thoroughly as you can. Make a detailed record of the problem and the

steps preceding the problem. E-mail this to us with your phone number

and the best time to reach you. We will send a resolution as soon as

possible or give you a call to discuss the problem.

Phone

(650) 964-3666

If you cannot reach us by e-mail, or if the problem requires a discussion,

call WordSpring support at The Lexia Institute. You can leave a voice

mail message at any time. Let us know how to call you back and what

times are best. Also leave your e-mail address. Support staff will be

available to assist you either immediately or by arranging a mutually

acceptable time, weekdays and weekends included.

Mail 

The Lexia Institute

766 Raymundo Avenue

Los Altos, CA 94024

We can also be reached by regular mail at the address above. Again,

Write down your problem as thoroughly as you can. Include a detailed

record of the problem and the steps preceding the problem. Mail this to

us. We will send a resolution as soon as possible. Please include your e-

mail address and your phone number so that we can contact you

immediately.
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Appendix
Detailed Installation Instructions

This appendix provides detailed instructions on how to install WordSpring on particular

Windows and Macintosh operating systems.

Installation Instructions for Windows

Step What to Do How to Do It

A

Check that your

computer can run

WordSpring

Your computer should be at least a Pentium II or equivalent with 256 MB

memory and Windows 2000, 2000XP or later operating system.

To determine your computer's characteristics, click Start; then Control Panel;

then System. Click the General tab. The processor type, memory size, and

operating system are shown. You must also have a connection to the Internet

 

The display must be color and should have a resolution of at least 1024 X 768

pixels and must have at least 800 by 600 pixels.

To determine your display's characteristics, on the Control Panel click Display

and then click the Settings tab. The resolution and color setting will be

shown.

 

You must have at least 50 MB of available free space on your hard drive.

To determine how much space you have available, open Windows Explorer,

click on your hard drive (usually C:). The Disk free space is shown at the

bottom of the Explorer panel.

 You must have a CD drive and a Windows compatible printer.

B

Make sure you do

not have a folder on

your hard drive

named: Lexia

WordSpring

From Windows Explorer, select Tools then Find. Enter Lexia WordSpring

and press Enter. If a folder with the name Lexia WordSpring is found, move

any word lists or printing formats stored in this folder that you want to save to

a new folder named something like "Old Lexia WordSpring". Then, remove

the program by clicking on the Start button at the bottom of the screen,

clicking on Control Panels, and then double clicking on the Add/Remove

Programs icon. Select Lexia WordSpring and click the Add/Remove button.

 
Exit all other applications that are running on your computer by clicking File

> Exit

C Install the program 1. Insert CD in drive.

 

2. If the installation does not start automatically, double click on My

Computer on the Desktop, and then double click on the CD Drive named

WordSpring 2.5. Then double click on the Setup icon

 3. Follow the instructions provided by the installation program.

Readme  file

4. We suggest that you read the Readme  file for information about

installation and about the software. It can be found on the WordSpring CD

and in the Lexia WordSpring 2.5 folder that is installed on your hard drive.

D Restart

When you are informed that the installation is completed remove the

WordSpring CD from its drive, and Restart your computer by clicking Start at

the bottom of the screen, then Restart.

E Registration

5. You will be asked to register your software on our server. This requires an

Internet connection. You will be asked to enter a Registration Key. It is either

on your WordSpring  CD or on its case.
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Installation Instructions for Mac OS X

Step What to do How to do it on Windows

A

Check that your

computer can run

WordSpring

Your computer should have a G3 or later processor. From Finder, click on

the Apple menu at the upper left of the screen and select About this Mac.

The panel that appears will tell you what processor you have. You also must

have an Internet connection.

 
The operating system must be OS X version 10.3 or later. Check About this

Mac to determine your operating system

 

The display must be color and should have a resolution of at least 1024 by

768 pixels and must have 800 by 600 pixels. Select the Apple menu, then

System Preferences, and then double click on Monitors. The panel will tell

you the resolution of your monitor

 

You must have at least 50 MB of available free space on your hard drive.

From Finder, click once on the hard drive, then select File>Get Info.

Available (Free) disk space is shown near the middle of the panel.

 You must have a CD drive and a Macintosh compatible printer.

B

Remove any folders

on your hard drive

named: Lexia

WordSpring

From Finder select File>Find. Enter Lexia WordSpring after Name Contains

and Press Return. If a folder with the name Lexia WordSpring is found,

move any valuable word lists or printing formats stored there to a new folder

named something like "Old Lexia WordSpring". Remove the program by

dragging the Lexia WordSpring folder to the Trash

C Install the program
1. Insert CD in drive. Open the CD icon on the Desktop by double clicking

on it.

 

2. The Macintosh OS X operating system requires an administrative password

in order to complete the installation automatically. If you know this

password, select and open the "OS X with password" folder. If you do not

know the password, select and open the "OS X without password" folder.

Double click on the installer icon labeled Lexia WordSpring 2.5.

 3. Follow the instructions provided by the installation program.

 

4. We suggest that you read the Readme  file for information about

installation and about the software. It can be found on the WordSpring CD

and in the Lexia WordSpring 2.5 folder that is installed on your hard drive.

 

5. If you are installing without having an administrative password and if the

LPCourier font is not in the system font folder (Macintosh HD > Library >

Fonts), you will have to install it manually. There are several ways of doing

this. One way is to go to Finder, locate your user font folder (Macintosh HD

> Users > Your UserName > Library > Fonts), make an alias for this folder

by clicking on File > Make Alias, and drag this alias onto the desktop. Next

in Finder locate the LPCourier font in either the WordSpring  CD or in the

Lexia WordSpring 2.5 folder on your hard drive (Macintosh HD >

Applications > Lexia WordSpring 2.5). Drag the LPCourier font to the Fonts

alias you put on your desktop.

D Restart

When you are informed that the installation is completed, and after you have

installed the LPCourier font, restart your computer by selecting Restart in the

Apple menu. Remove the CD from its drive.

E Registration

You will be asked to register your software on our server. This requires an

Internet connection. You will be asked to enter a Registration Key. It is either

on your WordSpring  CD or on its case.
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